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ABSTRACT. Urban Garden Management Through the Use of IOT Monitoring 
Systems and Multi-Criteria Application. Modern cities face growing challenges in 
terms of food, the environment, and quality of life, making the opportunity to transform 
urban spaces into gardens increasingly relevant. The purpose of this paper is to present 
and detail the system developed within the U-GARDEN project, focusing on the creation 
and implementation of a multi-criteria application, including real-time monitoring of 
environmental conditions through the integration of IoT technology. This aims at 
efficiently managing various types of urban gardens, facilitating a sustainable approach, 
and optimizing plant development in these green spaces. The results obtained demonstrate 
the effectiveness of the developed system, providing users with the ability to identify and 
efficiently manage suitable locations for creating urban gardens, as well as monitoring 
real-time parameters relevant to optimizing environmental conditions and plant 
development. The QGIS-type application, enriched with a multi-criteria formula, proves 
to be a scalable and adaptable tool, contributing to the promotion of sustainable urban 
development by involving the community in managing green spaces. The system 
developed within the U-GARDEN project represents not only an innovative technological 
solution but also a practical and efficient tool for communities and other stakeholders, 
offering a sustainable way to transform cities into greener and more productive spaces. 
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1. INTRODUCTION 
Urban gardens, in their traditional forms of "community gardens" and city 

allotments, have long contributed to cities. A new wave of urban gardens has 
emerged in recent years; these gardens are different from the ones that existed before 
them in that they are the result of people's motivations related to sustainability. A 
cursory review of the many case studies on urban gardens that are available in the 
published scientific literature validates these goals, which include: sustainable eating 
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dynamics, sustainable lifestyles, and personal well-being stemming from demands 
for social inclusion and a sense of community. 

Due to its popularity in society and city planning, urban gardening, along with 
the effects of climate change on cities and their adaptation, is gaining a lot of 
academic interest. Nevertheless there isn't much scientific research on community 
gardening as a whole. The majority of this literature offers proof of the social benefits 
of community gardening, including stress relief and overall well being. Furthermore, 
little is currently understood about how events related to climate change affect the 
production of food in cities or how resilient urban gardening and the urban food 
supply are to harsh weather (Tomatis et. al, 2023).  

Urban gardening is a type of urban agriculture (UA), which is the production of 
livestock and crops inside the limits of a city. UA is common in private and business 
settings, on rooftops, in public areas, and in backyards. Urban farms, community 
gardens, allotment gardens, rooftop gardens, school and educational gardens, 
easement gardens, private gardens, windowsill gardens, guerrilla gardens, family 
gardens, vertical and hydroponics farming, balcony gardens, indoor farms, and 
rooftop gardens are just a few of the many varied initiatives that UA has to offer 
(Ribeiro et al., 2023). Our focus is on urban farms and the monitoring system 
developed for a better functioning of the garden. 

Recognizing their significance beyond food production, the “Promoting capacity 
building and knowledge for the extension of urban gardens in European cities” (U-
GARDEN) project employs interdisciplinary approaches to address needs and 
opportunities, facilitate stakeholder and citizen involvement, and evaluate social, 
cultural, and environmental impacts and also is the background of this research. 
Through Urban Living Labs, U-GARDEN aims to foster innovative business models 
and establish a multi-criteria framework for informed decision-making in locating 
urban gardens, contributing to resilient and eco-friendly urban landscapes. 

The two primary components of the system used in the U-Garden project are the 
IoT network for real-time monitoring of important variables for optimizing 
environmental conditions and plant growth, and the QGIS multi-criteria application 
for effectively managing locations suitable for the creation of urban gardens. The 
system's main objective is to manage various urban gardens in an efficient manner 
while encouraging a sustainable approach and boosting plant development in these 
green spaces. By means of methodical management, the system guarantees a 
sustainable methodology, enabling users to identify suitable locations for the 
development of urban gardens. This developed system is unique in that it is efficient, 
enabling users to continuously monitor relevant parameters in real-time in addition 
to identifying ideal locations. The optimization of environmental conditions that are 
essential for promoting strong plant development in urban garden spaces becomes 
possible by this real-time monitoring. 

This article is structured as follows: related works summarizing research by 
different authors on IoT technologies, GIS and real-time monitoring of important 
parameters, implemented in projects based on urban agriculture. It follows the 
implementation of the system, which addresses multi-criteria applications and real-
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time monitoring of the urban laboratory implemented in the project. Also, the results 
obtained are detailed in the next chapter, at the end concluding with some important 
aspects of the research carried out in the U-Garden project.  

 
2. RELATED WORK 
The topic of urban gardening has changed dramatically since the advent of 

technologies such as Geographic Information Systems (GIS) and the Internet of 
Things (IoT). Urban gardens can now gather data on soil quality, moisture content 
and other parameters in real time by utilizing smart sensors and IoT devices. GIS 
technology is essential in enabling gardeners to assess geographical data and decide 
the best way to distribute resources. Urban gardening becomes an effective practice 
thanks to the synergy between IoT and GIS, creating sustainable green spaces in 
urban environments. 

The recognition of the significance of integrating novel technologies into 
precision agriculture is growing within the literature. A new era of "modern 
agriculture" has been established with the growth of IoT and information 
management technologies. The design and implementation of a system using IoT 
technologies along with a number of sensors is presented in the study by Carrión et 
al. (2018). Equipped with sensors for CO2, humidity, luminosity, temperature, and 
plant detection, the system incorporates a hybrid application for remote monitoring 
connected to a local area network. The communication process utilized by the system 
undergoes testing, with a comprehensive evaluation of its performance and 
reliability. The primary goal of the article is to promote agricultural production 
within urban areas, using the advantages of IoT technology in the context of urban 
gardening.  

China's fast urbanization in the last few decades has brought attention to the need 
for greater efforts in urban gardens, which frequently face issues including poor 
management and expensive operating costs. These difficulties have an impact on 
both urban growth and the populations' quality of life. Therefore, utilizing state-of-
the-art technology, the authors Chang and Tan (2022) of Ankang University in China 
carried out a study to enhance the digital administration of urban gardens. Their 
study aims to explore the feasibility of creating a digital management system for 
plant growth status in urban gardens and its development. This work mentioned 
above describes the design and implementation of the system, including the 
hardware and software components, the data acquisition and processing methods, 
and the system functions. There are also presented experimental results and analysis, 
which show that the system can effectively collect and display the image data of 
garden plants. 

The study by Thebault et al. (2020) describes a decision-making approach for 
ranking a group of buildings based on their potential to host solar systems in the 
urban environment. The study is part of a Franco-Swiss effort focusing on the 
Greater Geneva area. The authors address the problem using the ELECTRE III 
outranking approach, which provides an efficient ranking of the various solutions. 
They take into account a variety of features, including energy, economy, heritage, 
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and roof structure. They apply the strategy to a Geneva district and compare the 
outcomes to alternative scenarios that just take into account one factor, such as solar 
irradiation or payback period. They conclude that the suggested multicriteria method 
incorporates the complexity of the urban environment and delivers more relevant 
information to urban actors. 

Another study by Baker and Smith (2019) made in order to categorise UK urban 
garden surfaces investigates the methodological implications of combining GIS with 
an Object Based Image Analysis (OBIA) remote sensing methodology that makes 
use of extremely high resolution Worldview-2 images. Gardens were categorized 
with an overall accuracy of about 86%, focusing on a 7 km2 research area in 
Leicester, UK. The results demonstrate how GIS and OBIA analysis may be used to 
map urban garden surfaces in the UK, providing a useful framework for further 
research. Insights related to urban greenspace analysis in other UK urban regions 
were revealed by further analyzing the obtained dataset to find connections between 
garden greenspace percentage and physical garden attributes. 
 

3. SYSTEM IMPLEMENTATION 
The system implemented in the U-Garden project is based on two main elements, 

namely the multi-criteria application to efficiently manage suitable locations for the 
creation of urban gardens and the IoT network for real-time monitoring of relevant 
parameters for optimizing environmental conditions and plant growth. In the 
following we will discuss the functionality of the two key elements of the U-Garden 
system separately. 

3.1. Multi-criteria application  
The Multi-criteria application is a web application designed to simplify decision-

making for urban garden locations. It serves as an interactive and user-friendly 
platform, allowing various stakeholders, including public administrations and 
associations, to input their data. Users can categorize variables, weigh them based 
on personal criteria, and obtain a visual output. This output helps identify vacant 
plots suitable for urban gardening, aiming to democratize the location process by 
empowering users to make informed decisions using their own defined variables and 
criteria. 

After loading the application, users import data and select variables for analysis, 
which can be in raw form or min-max scaled. Variables can be assigned to 
dimensions, and users can adjust weightings based on importance through interactive 
controls. The application calculates a final score, aiding users in identifying optimal 
plots based on their specified criteria. Visualization options include an interactive 
map for spatial data and an interactive table for non-spatial data. The application 
offers flexibility, allowing users to refine their analysis as needed. 

Imported data will be in the form of polygons or spatial points, representing the 
locations of interest. These data include associated attributes, which serve as 
variables. Users can select and categorize these variables into dimensions such as 
Spatial, Urban, Environmental, Economic, Political, and Social. Each dimension 
receives a score, calculated as the arithmetic mean of its assigned variables. 
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Fig. 1. The selection and classification of variables 

The user interface is intuitive, offering tools and visualization options. Users can 
choose the base map source, apply filters, conduct searches, and adjust settings. The 
outcome is a clear visual representation, aiding users in identifying suitable plots for 
urban gardening. 

 
Fig. 2. The identification of plots on the map 

 
Key functionalities include the "Home" menu for general configuration and 

common tasks, the "View" menu for data display customization, and the "Tools" 
menu for data analysis and manipulation. The "Help" menu provides guides, answers 
to common questions, and contact information for assistance. 

 
3.2. Real-time monitoring 
The second important element of the system is the IoT real-time monitoring 

network. The architecture of this network is detailed in Fig. 3. 
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Fig. 3. The system architecture 

 
For the implementation of the IoT monitoring system of the urban laboratory is 

used the monitoring station, Smart Agriculture PRO, high precision, provided by the 
manufacturer Libelium. The components of the urban environmental quality 
monitoring system, in addition to the IoT station and the sensors used for monitoring 
parameters, are: the Gateway, which collects data in real time and regularly transfers 
them to applications and databases, and manages the communication protocols of 
the sensors; the InfluxDB database, which allows real-time recording of parameters 
from the monitoring station; the Grafana platform used to visualize the parameters 
monitored by the Libelium station. 

The data captured by the sensors is transmitted to a data concentrator via Wi-Fi 
or 5G and then sent to the cloud via a network protocol called MQTT (Message 
Queuing Telemetry Transport). Here, this data is stored in a database and processed 
for further use. The choice of the MQTT protocol is characterised by its efficiency 
and simplicity of use, allowing data to be transferred without requiring significant 
resources from the IoT (Internet of Things) platform. 

 

 
Fig. 4. Grafana dashboard visualization 
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The database used in the system is InfluxDB, taking into account the numerous 

advantages it benefits from. This system is specifically optimized for storing time 
series data, with outstanding performance in both writing and reading information.  
These features ensure efficient management of data from IoT devices, facilitating 
successful data development, monitoring and analysis. 

The Grafana visualisation platform, allows users to access data in graphical or 
tabular format, apply mathematical formulas to graphs and set up alerts. Using this 
platform, data can be extracted from the database and analysed in terms of its 
evolution over time (Fig. 4). 

 
4. RESULTS 
4.1. Multi-criteria application 
To explain the functionality of the Multi-criteria application we will prepare a 

report on which empty plots would be the most suitable for the implementation of 
an urban garden in the Bucharest metropolitan area. For this we found some vacant 
plots, obtained their spatial polygons and scored a set of criteria for each one. Some 
of these criteria include the size (in m2) of the plot, shape index, soil quality, budget, 
percentage of elderly people in the neighborhood in which it is located, among 
others. First we open the application and start loading the file containing the 
polygons of the plots and their characteristics. 

 
Fig. 5. The json input data  

Once the file is loaded, the application recognises the attributes as variables and 
we start grouping each variable in the corresponding dimension. For example, we 
group the plot size variable into the spatial dimension. Similarly, we group the 
percentage of elderly population variable into the social dimension, soil quality in 
the environmental dimension and the budget into economic dimension.  
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Fig. 6. The assignment of variables based on input data 

 
Initially, the total score of all plots is 0, since by default the weighting of all 

dimensions is 0. On the contrary, if the weighting were identical between 
dimensions, the total score would simply be the arithmetic mean. 

 

 
Fig. 7. Display plots with score 0 

 
We decide to weight the dimensions as shown in Fig.8. The color of the plot will 

change according to the highest score. 
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Fig. 8. Display of the plots after applying filters  

 
To see the score of each plot, we switch to the table format, the results are shown 

in Fig. 9.  

 
Fig. 9. The table format of plots score 

  
We can see here that Vacaresti Park has the highest score which is 0.5. This value 

is obtained as follows: Each plot has a normalized value for each category based on 
how we grouped the variables. For example if we put size in the spatial category then 
that category value will be decided only based on each plot size alone. If we grouped 
multiple variables in the same category then we will make the arithmetic mean of all 
normalized values. In our case, the biggest score (1) for the spatial category will 
correspond to the  biggest plot in size and the smallest score (0) smallest plot. All 
other intermediate values will be in (0,1) interval. 

Following the calculation, the result will be as follows: (50*0 + 100*1 +0*1 + 
0*0.15 + 50*0 + 0*0.8) / (50 + 100 + 0 + 0 + 50 + 0) = 100/200 = 0.5. 

This value corresponds to yellow based on the total score legend so the plot will 
be colored accordingly. 
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4.2. Real-time monitoring 
In terms of interpreting the results in terms of real time monitoring in urban 

gardens, we will continue to analyse the most important parameters monitored in the 
urban garden over two months, presenting them in individual graphs. In Fig. 10, we 
can see the variations of solar radiation, which shows an increase during the day and 
a decrease during the night. It can also be seen that solar radiation gradually 
decreases as we approach the autumn season.  

 

 
Fig. 10. The solar radiation variations 

 
Fig. 11 and 12 show the variations in air temperature and soil temperature. These 

two variables are closely correlated, and it can be seen from the graphs that they 
evolve in a similar way. Thus, thermal changes in the atmosphere can have a 
significant impact on soil temperature and vice versa, which contributes to a deeper 
understanding of the thermal dynamics within this urban garden. 

 

 
Fig. 11. The soil temperature variations 
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Fig. 12. The air temperature variations 

 
Thus, the modular structure of the U-Garden project proved essential for the 

analysis and interpretation of the data collected in the urban garden. This approach 
facilitated the identification of significant correlations, such as the relationship 
between variations in solar radiation and recorded temperatures, bringing value to 
the understanding of environmental dynamics and supporting informed decision-
making for urban garden optimization. 

 
5. CONCLUSIONS 
 
In conclusion, this paper has successfully addressed the current challenges of 

modern cities in terms of food sustainability, environmental quality and overall 
urban living standards. The combination of the Multi-criteria application and the 
IoT-based real-time monitoring network proved to be a robust and effective system 
for transforming urban spaces into productive and sustainable gardens. 

The Multi-criteria application serves as a powerful decision-making tool, 
democratizing the process of selecting suitable locations for urban gardens. The app's 
flexibility and visual outputs contribute to informed decision-making, empowering 
users to actively participate in the creation and management of urban green spaces. 

On the other hand, the real-time monitoring network, based on IoT technology, 
provides valuable information on environmental conditions in urban gardens. This 
real-time data facilitates a deeper understanding of the dynamics within the urban 
garden, highlighting correlations between environmental factors and supporting 
data-driven decisions for optimal plant development. 

In essence, through this work we not only introduce an innovative technological 
solution, but also establish a practical and effective tool for communities and 
stakeholders. The success of the U-GARDEN system exemplifies its significant 
potential in contributing to the future of urban planning and sustainability. 
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